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Introduction 
 

Using Monitoring & Assessment (M&A) for Adaptive Management 
 
Implementing and managing interventions for natural resource management is a 
complex affair. The environments in which we operate tend to be highly dynamic, and 
require us to frequently respond and adapt in order to achieve our objectives. In order 
to do so, we need to be in a position to identify and understand the changes that 
occur, both as a result of our interventions and those external to our sphere of 
influence.   
 
Monitoring and assessment (M&A) is fundamental to identifying, understanding and 
learning about the changes we bring about and are influenced by. It can enable us to 
manage our interventions more strategically and our operations more efficiently. M&A 
involves the means by which we gather and analyse relevant information to make 
sound decisions; create new insights; empower stakeholders to understand and 
therefore better manage their own resources, as well as ensure accountability.  
 

 
 
In order for M&A to be useful, we need to ensure that we have some basic elements in 
place to give us the information and insights that we need. These include: 
 
§ A clear understanding of the changes our interventions seek to bring about and 

the relationship between these changes; 
§ Mechanisms for data & information gathering;  
§ Processes and capacity to store and analyse data & information; and 
§ A learning environment that promotes and encourages interpretation and 

reflection on the information gathered, identification of successes and openness 
to mistakes, in order to generate new ideas for making improvements 

  
 
 
 
 
 

Monitoring is the gathering of data on a regular basis and the use of this data to 
check on progress of the intervention to determine whether or not it is on track and 
things are happening as expected.    
 
Assessment is the process of analysing data and interpretating the results in order to 
make judgements about the situation or processes being employed. Assessments are 
often undertaken through specific events that can be either internal or external and 
are used to gain an in-depth understanding about the overall intervention in terms of 
progress and impact.  
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Overview of M&A systems in the Tanga Coastal Zone Conservation 
and Development Programme  
 
The primary objective of the Tanga Coastal Zone Conservation and Development 
Programme (TCZCDP) is to maintain healthy marine ecosystems which in turn will 
support productive fisheries which in turn will improve the livelihoods of coasta l people. 
 
To achieve the Programme objectives the TCZCDP has focussed on improving the 
management of coral reefs and mangroves through establishing six Collaborative 
Management Areas (CMAs) which are community initiated with the support of District 
and Regional Government. The CMAs employ a range of management interventions 
which are captured in the CMA Plans (CMAPs), and these include: closure (full 
protection) of certain coral reefs for fishery management and/or habitat recovery; 
restricted fishing gears; patrolling to prevent illegal and destructive fishing gears 
being used; and controlled mangrove harvesting. As the Programme developed, it 
established monitoring programmes for the various sectors and ecosystems it was 
interested in assessing, thereby established five primary datasets. These are: 
 

• Reef health 
• Fisheries 
• Mangroves 
• Patrolling 
• Socio-economic status (initiated in 2004) 

 
Monitoring by communities or District officers through measuring a large number of 
variables (parameters) of these ecosystems or sectors has evolved since around 1998. 
Various experts have provided advice and recommendations on methods and 
variables to measure, based on international best practice. However, one sector, the 
socio-economic monitoring was only initiated recently (2004) and is still in the process 
of development.  
 
It was soon recognised that as the five monitoring programmes had been developed 
more or less separately they tended to operate in isolation. This essentially made it 
extremely difficult to generate a holistic picture of the status and links between marine 
resources and socio-economic health and understand the cause and effect relationships 
between impact and outcomes (For example, the relationship between raising 
awareness, implementing by-laws and reef health).  
 
Consequently, in 2005, the Programme set out to bring together the existing 
monitoring programmes and data sets and develop a simple, yet comprehensive and 
sustainable Information Management System. The design of the Information 
Management System was based on a review of the existing systems and practices1, 
during which information needs of key stakeholders at Regional, District and Village 
levels were identified.  
 

                                                 
1 Pabari, M., Matiru, V., Muniu H., and G.Thande (2005) Building capacity for the use of Monitoring and 
Assessment in adaptive management: Review of existing systems & practices in Tanga. 
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Overview of the TCZCDP Information Management System  
The key elements of the TCZCDP Information Management system are illustrated in the 
diagram below, and form the basis for this guide. A major component of the TCZCDP 
Information Management System, is an Access based database, called the Info Dbase, 
which stores the data and generates reports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Information Management System is intended primarily to support the management 
of the coastal and marine resources of the Tanga region. Consequently, the “clients” of 
the system include:  
 
Relevant institutions at the Village level, including:  
 
§ Village Governments – To enable them to make informed decisions regarding the 

development and implementation of CMAPs – such as writing approval letters for 
mangrove harvesting permits, proposing By-laws, developing action plans for 
replanting & patrols; identifying reefs to be closed and surveyed by members of 
the Village Monitoring Team (VMT). 

 
§ Village Environmental Management Committees – To assist them fulfil their role 

as an advisory body to the V/Govts. 
 
District level staff: These include (but are not limited to) the District Executive Director 
(DED) who is responsible for making policy decisions and providing progress reports to 
the Central Government; the District Natural Resources Officer (DNRO) and District 
officer assigned as Coordinator to oversee the implementation of the Programme in 
his/her District; District Technical Officers who provide technical support in particular 
areas to the Programme; and Extension workers who are responsible for gathering 
data from the villages.  
 
Regional level staff: Provide technical advice to the Districts. 
 
Central Coordinating Committees: Responsible for reviewing progress and 
developing and harmonising CMAPs and Village By-laws. 
 
Others: Such as researchers; non governmental/international institutions and/or 
projects (e.g. IUCN, TCMP, SEEGAD, the University of Dar es salaam, CORDIO) with an 
interest in the Programme and its activities. 
 
Each of the “clients” described above has a significant role to play in ensuring that the 
overall Information Management system is implemented effectively. These roles are 
illustrated in Figure One below 
 

� (Re) Define 
Information Needs 

� Collect Data � Enter data in 
Info DBase 

BACKUP & ARCHIVE THE 
INFO DBASE � Analyse Data & 

Generate reports 

If you continue to have 
errors after you have 
checked and ensured 

� Review & revise 
plans 
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Figure One: Overview of Roles & Responsibilities within the Information Management System 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Legend*:  
 
VDCC - Village Data Collection Clerks 
VDA - Village Data Administrators 
DDA - District Data Administrators 
DDEC - District Data Entry Clerk 
RDA - Regional Data Administrator 
 
*(Refer to Part One, Section Three for further information on roles & responsibilities)  

�Participatory planning 
meetings held at village & 
district levels to (re)define 

information needs 

�VDCC collects data, 
filling in the data 
sheets as required 

�VDA collects the completed 
data sheets for delivery to 

District and distributes new ones 

DDEC Backs Up 
Info DBase & 
Sends to RDA 
for Archiving 

�DDA receives 
completed forms & 
distributes new ones 

�Meetings are held in 
V/Govts; CCCs; and Districts to 

interpret reports 

�Participatory Planning 
Meetings held to review & 

revise plans 

�DDEC enters data into 
the Info Dbase & 
produces reports 
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Overview of the Guide  
 
This Guide provides a short description of each of the activities within the overall 
Information Management System, and uses of the system for adaptive management 
within the TCZCDP. The Guide is divided into two parts. The first part of the Guide 
provides an overview of the different elements within the overall Information 
Management System, and contains the following:    
 
 
Section One: Defining Information Needs  
Section Two: Data Collection  
Section Three: The Info DBase – Roles and Responsibilities  
Section Four: Entering Data into the Info DBase 
Section Five: Maintaining the Info DBase  
Section Six : Analysing Data and Generating Reports    
Section Seven: Using Monitoring and Assessment for Adaptive Management  
 
Data collected through the Information Management System is stored and analysed 
through a database - the TCZCDP Info DBase. The second part of the Guide provides 
details on how to use the database – including installing the system, entering data and 
analysing and generating reports.  
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PART ONE 

OVERVIEW OF THE INFORMATION MANAGEMENT 
SYSTEM 
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Section 1. Defining Information Needs 
In order to assess whether the management 
interventions put in place in the Tanga region to 
achieve the Programme’s objectives are working, 
we need to monitor and assess key variables 
that will provide a measure of success. Such 
variables that provide a clear and measurable 
indication of success are termed indicators. 
Choosing indicators is therefore the key step in 
defining what information is needed to make 
management decisions.  

1.1 Identifying Variables 
There are a very large number of variables that can be measured but not all will be 
good indicators. The following steps are useful in defining what information you will 
need and which variables will serve as suitable indicators to assist you to manage your 
marine & coastal resources and achieve your overall Goal.   

A. Define clearly what you are trying to achieve with your management 
plan.   

If, for example, your overall Goal is to: “Maintain healthy marine ecosystems and 
fisheries to support sustainable livelihoods” – Ask yourself: What are we doing to 
achieve our overall Goal? What are our key areas of interest?  

B. Discuss what you should measure in relation to your key areas of 
interest? These are your Variables  

When you are choosing your variables, you need to make sure that they are:  
 

i. Specific to goals and objectives and Relevant to managers/resource users: 
Variables must be directly linked to management goals and activities. For 
example – you might decide that it would be useful to measure water 
temperature. Ask yourself; 

 
ü How is this connected to our goals and activities?  
ü If we collect this information – how will it help us to make decisions in the 

future?  
 

ii.  Measurable: There is no point selecting a variable that you cannot measure! In 
order to be sure that your variable is measurable, you need to consider the 
following:  
ü Cost & Logistics: We are always faced with limited funds, people and 

equipment, and constrained by logistics in the field such as travel time. 
Therefore, we need to be sure that we can measure our variables with the 
resources we have.   

ü Replication: Often, community members ask data collectors “why are you 
asking me these questions again, didn’t you just do it last week”? The need 
to collect the same data many times is because one measure tells us very 
little, and it is important to calculate averages, based on a good 
representative sample. To measure average catch in a year we need to 
measure catch from a number of fishers, not just one fisher. Similarly, to 
measure the average percentage live coral cover on a reef, we need to 
lay several transects not just one, and take the mean of those transects. 
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iii. Sensitive to change & Timely : Management decisions need to be made on a 
regular basis and within a given time. If decisions were only made once in 5 
years, things might go very wrong in the meantime. Therefore, it is important that 
your variables are sensitive and will change in response to interventions in a 
timely manner. For example, live coral cover is a very useful and a widely 
recognised measure of reef health. But coral does not grow quickly and therefore 
change is only likely over years rather than months with this indicator. Therefore 
you may also want to measure another variable that responds more quickly, such 
as certain fish species.  

C. Decide on where & how often you should collect your data  
Deciding on the location and timing of your data collection is the design aspect of your 
monitoring programme. For example: 
 
? To monitor fisheries, do we collect data in every village, or in only selected 

villages per CMA? Do we collect this data every day, every month, or twice a 
year?  

? For monitoring reef health, do we do surveys on every reef, or selected reefs, if so 
which reefs? Do we make sure for every closed reef we survey at least 1 or 2 
open reefs? Do we select representatives from the inner coastal reefs and the 
more distant offshore reefs? Do we measure the density of crayfish on the reef 
once a year or every month?  

 
Some of the answers to these questions will be driven by cost and logistics (see above), 
but within these constraints the design must be scientifically rigorous otherwise the data 
collected will not provide the answers. Consider the following examples:  
 
Example One: Collecting Fisheries Data 
In thinking about the design of your data collection, you need to think carefully through 
all the factors that are likely to affect the variable you are collecting. For example, if 
you are collecting data on fisheries and you know that fishers tend to go out more 
frequently during the North east monsoon (kaskazi) because the weather is better, then 
you must factor this into your design. So, if you collect data one month a year, this 
month should always be the same season. For example, if you collected your fisheries 
data in Pangani in May (kusi) and in Tanga in October (kaskasi), you cannot compare 
these data because they have been collected from different seasons. In other words, if 
the Catch Rate is higher in Tanga you cannot say this is because the Catch Rate is 
generally higher in Tanga compared to Pangani, it might simply be because fishers 
catch more in the kaskazi.  
 
Example 2: Collecting data on the health of Mangrove Forests in the Region 
If you want to know the average density and height of mangroves in Tanga Region 
over time in order to make general statements about the health of the mangrove 
forests in the Region you will need to collect data over a range of locations in all three 
Districts. Therefore if you only measure mangrove height and density in one village in 
Pangani, you can only reflect and talk about that particular stand of mangroves. If you 
collect data from say two villages in each of the three Districts you will feel more 
confident that when you look at the trends you are able to reflect on trends for the 
Region rather than one village. However, if in this example you collect the data from 
the villages in Pangani in year 1, year 3 and Year 5, from Muheza, in Year 3 and 
Year 6, and from Tanga in Year 5 and Year 6, you are not in a good position to 
combine the data and look at general trends. The general rule is to decide on your 
collection unit – e.g. 2 villages per District, and repeat this every time you collect data, 
e.g. twice a year 
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D. Review your indicators at least once every two years 
As you conduct your monitoring programmes and analyse your data, you will gain 
experience and a better understanding of which indicators are Specific, Relevant, 
Measurable, Sensitive and Timely.  
 
You may find certain indicators you have chosen are too difficult to measure, or are 
not responding to your management intervention quickly enough and cannot therefore 
tell you how successful your management is. Therefore, it is wise to review the 
indicators you have chosen at least every two years. While doing so, consider your 
experiences as well as the analyses done to date – what have your reports been 
telling you; what other information might you need? Were there certain types of data 
that were expensive/difficult to collect?  
 
To select suitable indicators is a science in itself, and in terms of tropical fisheries and 
coral reef ecosystems, it is a complex process because both the fisheries and the 
ecosystem they are based on, are highly complex and changeable involving a large 
number of variables that vary naturally. Fortunately, TCZCDP has amassed a large 
amount of data over the eight years of monitoring (particularly of Reef health and 
Fisheries), and therefore detailed analyses of these data have been possible to assess 
which variables are sensitive to change and can therefore serve as good indicators of 
successful management2.  The Information Management System developed for the 
Programme includes a group of indicators which have been selected for the TCZCDP, 
based on the data analyses, and from experience from other marine resource 
management programmes in the Eastern African region and elsewhere. The TCZCDP 
Info DBase has been designed to generate reports based on these key indicators so 
that monitoring data are analysed in a systematic and regular way and results 
examined to assess the success of the Programme’s management interventions. 
 

                                                 
2 Refer to: Anderson, J. (2004) Analysis of reef fisheries under co-management in Tanga; Samoilys, M. 
(2004) Review of the Village Monitoring Team’s coral reef monitoring programme in Tanga; Othina, A. 
and Samoilys, M. (2005) Impacts of management on coral reefs in Tanga. 
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Section 2. Data Collection 
 

2.1 Data collection in TCZCDP  
 
There are two types of data – primary and secondary data. The former refers to 
data taken by a person or an institution for their own analysis and decision making 
processes. If the data is from another person/institution, then this is referred to as 
secondary data. Secondary data may also be from published sources or reports (such 
as population census statistics).  
 
The data that is stored and analysed through the TCZCDP database is primary data 
and is collected through directly measuring the status or change of a specific indicator 
– for example numbers of mangroves planted, changes in the percentage cover of live 
coral, changes in the number of bomb blasts over a period of time.  
 
The design for data collection has changed over time, with experience and to meet the 
needs of the Programme. For example, details of data collection design for the Reef 
Health monitoring are presented in the tables below (also refer to data collection 
forms in Annex Two).  

A. Fish density data collection design 
Date Size 

From To 

No. of 
transects 

(replicates) Length Width 
Repeat 
counts 

Area of 
transect 

(m2) 
1998 2000 2 100 5 1-4 500 
2001 2003 2 50 5 8-10 250 
2004 To date 10 50 5 1 250 

B. Mobile Invertebrates data collection design 

 Date Size 
Area of 
transect 

(m2) 
From To 

No. of 
transects 

(replicates) 
Length Width  

1998 2000 4 20 5 100 
2001 To date 10 10 5 50 

C. Line intercept transect (LIT) data collection design 
 Date Size 

From To 

No. of 
transects 

(replicates) Length Width 

1998 2000 4 20 5 
2001 To date 10 10 5 
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2.2 Data Collectors - Guidelines for Good Practice 
 
When collecting data, it is important to bear in mind the following principles3:  
 
ü Ensure that you have a field book to record when you went to the field, what you 

did, and any problems you encountered when collecting data 
ü If you fill in the data in a rough sheet in the field and transfer it to a clean data 

form, do so on the same day. Using the same data sheet form from the field is 
preferable as it avoids possible errors in transferring data. 

ü Fill in all fields on data sheets, even when you think it is repetitive.  
ü Enter full dates on the form, ensuring that you spell out the name of the month (e.g. 

12-May-2002). Different countries use different formats (e.g. dd/mm/yy OR 
mm/dd/yy), which can be confusing 

ü Always indicate which measurement units you are using (e.g. cms, kgs)  
ü Avoid abbreviations unless they have been defined and documented elsewhere.  
ü Make sure your writing can be read by other people. Check your data sheet form 

when you return from the field.  
ü Make sure your have two copies of each data sheet, one to send to the District 

Office, and one that is stored in a safe place.  
 
Data collectors play a very important role, which is not always easy. In addition to 
difficulties such as getting to a particular site, data collectors often come across people 
that are suspicious of them, and reluctant to give the information required. The 
following tips may assist data collectors in such situations:  

 

☺ Be Open & Transparent - Make sure you explain who you are, why the information 
is being collected, and how it will be used.  

☺ Ensure Confidentiality – Data collected should only be used in combination with 
other data. Explain this to the individual, and ensure that they know their name and 
their personal information will not be used in any of the reports. 

☺ Ensure you are understood – If you ask a 
question and do not get a clear answer, it is possible 
that the person did not understand the question or is 
suspicious of it. Rephrase the question, using different 
words without changing the meaning; and/or politely 
state that you were not clear on their answer and ask 
them to repeat it for you.   

☺ Always be courteous and polite – Remember that 
the people you are collecting data from may be tired 
from a hard day’s work and anxious to get home. 
Getting angry, arguing or being impolite will only make it more difficult for you next 
time and make it harder for them to trust you.  
 

                                                 
3 From Samoilys, M & Giles, B. (2003). Data management. Project Seahorse Technical Report No. 5, 
Version 1.0. Project Seahorse, Fisheries Centre, University of British Columbia.   
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Section 3. The TCZCDP Info DBase: Roles & Responsibilities 
 
In order for the database to effectively contribute to the overall Information 
Management System, the people that will use and benefit from the system all have a 
very important role to play. In each District and at the Regional level - individual staff 
have been given the responsibility for ensuring that activities related to data collection, 
storage and analysis are carried out effectively. These are as follows:  
 

1. The Village Data Collection Clerks (VDCCs). The role of the VDCC is to fill out the 
data collection forms and hand them into the Village Data Administrator to be 
taken to the District officers 

2. The Village Data Administrators (VDAs). The VDA is responsible for collecting the 
completed forms from the VDCCs and taking them to the District Data 
Administrator (DDA) once a month. The VDA is also in charge of collecting new 
forms from the DDA, distributing them to the VDCCs and ensuring that they know 
how to use them.  

3. The District Data Administrators (DDAs). The role of the DDA is to receive 
completed forms from the VDA; to check them to see that they are complete and 
readable; to deliver them to the District Data Entry Clerk (DDEC); and to provide 
the VDA with new forms and ensure that they are trained in their use. 

4. The District Data Entry Clerk (DDEC). The DDEC is responsible for inputting all 
data into the database; verifying the data, performing backups and producing the 
required reports. The DDEC is also required to liase with the Regional Data 
Administrator on a regular basis, hand over the backups and ensure that they are 
aware of any requirements/problems the District might have. 

5. The Regional Data Administrator (RDA). The RDA is responsible for receiving 
backup copies of the District Info DBase from the DDEC, updating the Regional Info 
DBase with District Information and archiving it in a safe place. The RDA also 
responds to requests for specific reports from Districts or other institutions; and 
provides backup support to the Districts.  Last, but not least, the RDA is 
responsible for approving and authorizing all changes to the settings of the 
Info DBase.  

6. The Monitoring Coordinator. The Monitoring Coordinator is responsible for 
providing technical support to the Districts for the identification of information 
needs, the design of data collection tools, and data analysis and interpretation. 
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Section 4. Entering Data into the Info DBase 
 
The accuracy and usefulness of the information and reports 
generated by the database is completely dependent on the 
data that is entered into it. Therefore, while entering data can 
be a tedious business, it is extremely important that it is done 
accurately.  
 
When entering data, bear in mind the following 3: 
 

ü If you make any corrections/amendments to the data forms, make sure you 
clearly mark them on the hard copy of the data form, put in the date and 
your signature against your changes. 

ü Make sure you distinguish between values which were not obtained, i.e. 
missing data, versus values which were obtained but were zero. Zero’s are 
important data and should be recorded either as “0” or “none”. If the data 
is missing, then the record should be left blank.  

ü File hard copies of the data sheets in a safe and orderly manner for future 
reference. 

ü When you have completed entering data for the day, cross check your 
entries. This process is called data verification and should be carried out at 
both the District & Regional level. It is most easily done by two people 
together, as follows:  

 

District Data Verification 
• Data Entry Clerk exports data to Microsoft Excel and prints out 

work sheet. 
• Data Administrator verifies data entered with  Data Entry Clerk: 

DEC reads out data from printed spreadsheet while DA crosschecks 
against original data forms.  

• DEC highlights errors on printed spreadsheet and then makes 
changes to Info DBase.  

• Data is exported to media (CD etc) and sent to Regional office. 
• Sign and date data entry forms that have been entered into 

database, photo copy and send copies to Regional office. 
 

Regional Data Verification 
• Exports Data to Microsoft Excel for District. 
• Prints Microsoft Excel work sheet. 
• Highlights errors and informs District Data Administrator. 
• Receive revised data.  
• Backup data. 
• Sign and date photocopies of data entry forms once verification is 

complete, and store data forms. 
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Section 5. Maintaining the Info DBase  
Data are the basis for generating useful information and 
making important decisions. Obtaining good data takes 
years of monitoring, and it is not enough to trust individual 
computers alone to store the fruits of such hard work - 
especially since it is very easy for them to break down! In 
order to be safe, it is important to ensure the database is 
used, maintained and stored in accordance with the 
instructions provided.    
 

5.1 Maintaining Settings of the Info DBase 
 
In order for the Info DBase to work properly, it must be set up properly before you 
begin to use it. This is done only by the RDA and involves entering the user groups, 
their passwords, as well as parameters such as the Districts and Village names, CMAs, 
Reefs and Data Recorders.   
 
Once settings have been entered, they can only be changed by the RDA. If a District 
wants to change any of the setting (such as add/delete a data recorder), they must 
inform the RDA who will make the required changes. These changes must be made to 
all the databases – those in the Districts, as well as the Regional Office. If this does not 
happen, and the settings in one District are different from that of the Regional Office, 
then that District will not be able to be backed up or archived to the Regional Info 
DBase (see Part Two, Section 6.2).  
 

5.2 Archiving & Backing Up the Information Database  
Archiving and backups are used to save data and information in case of damage/loss 
and to allow future users to work with the data in different ways, if the need arises.  
The two processes are used in different ways, as show in the illustrations and described 
further in the table below.   
 
The TCZCDP Info DBase is archived and backed up using the import/export utility (See 
Part Two, Section 6).  
 
Backups are carried out every day and at the end of every month, by exporting the 
District Info Dbase to a CD. The CD is then stored in the District Office in a safe.  
 
Archives are carried out every six months by exporting the District Info Dbase to a CD, 
and then importing it from the CD into the Regional Info DBase which is backed up on 
another CD and kept in a safe.  
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Backing up/Archiving District Info DBases 
 

 
 
 
 
 
Archiving the District Info DBases 
 
 
 
 
 
 
 
 
 
 
 
 
 
When backing up/archiving your database, ensure that3:  
 

ü All data has been verified before it is backed up (refer to Section Four)  

ü The CD actually has the information on it. After you have saved it – open and 
view the file 

ü The CD on which the database is backed up on is stored in a safe place AWAY 
from your computer. Any event that affects your computer (e.g. fire or theft) 
should not affect your back up disks  

ü Clearly label your CDs with the District name and the date it was created 

ü Always produce two copies of the archive, and store them in separate places 

ü Never destroy/write over your archive CDs – you will need them to provide a 
history of the evolution of your database 

District Info DBase 

 
District Info DBase 

Archive 

 

Regional Info DBase 

 

EXPORT 

EXPORT 

 
District Info DBase 
Backup/Archive 

IMPORT 
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ü Archiving and Backing up the Info DBase – Summary Information 
 

Backups Archives 
General Description 
Backups are used to save data on a daily 
basis.  

Archives are used to save data over a 
longer time period (e.g. monthly or 
yearly), and are used to provide a 
history/track the evolution of the 
database  

Data can be kept in the same building, 
but on a different media (e.g. another 
hard disk, CDs etc) and therefore access 
to the data is readily available 

Archives should be kept in a safe, 
away from the office in which the 
databases are kept. Therefore, access 
to data is not readily available and 
may take time to retrieve and reload 

The format/media on which the data are 
stored can be semi-permanent (e.g. Flash 
disks, CDs, or floppy discs) 

The format/media on which the data is 
stored is more permanent and can last 
for longer periods of time (e.g. Tapes, 
Zip drives, CDs, DVDs) 

Procedures 
Timing: Daily & Monthly 
At the end of each day and each month, 
the database should be backed up on a 
Flash Disk or a CD.  
 
It is wise to use two Flash Disk/CDs, one 
for each alternative day/month. For 
example; on Monday use CD1 and 
Tuesday CD2. On Wednesday, write over 
CD1 and Thursday, write over CD2.   
 
For monthly backups use two CDs – one 
for each alternative month. For example; 
CD1 is for January, March, May, etc; and 
CD2 is for February, April, June etc.  

Timing: Semi-Annually 
At the end of every six months, backup 
up the entire database to a CD (or 
other permanent media). One is to be 
stored in the Regional office & one at 
the District Office. 
 
Semi-annual  archives should NOT be 
erased or reformatted as these are the 
true archive CDs 

Filing: Label all CDs/Flash Disks with a 
permanent marker as follows:  
Daily:  
CD/Flash Disk 1: “Backup1” (refers to 
Monday, Wednesday and Friday 
backups) 
CD/FlashDisk2: “Backup2”  (refers to 
Tuesday and Thursday backups) 
Monthly:  
CD1: “Monthly 1[year]”: Refers to 
alternate  months starting with January 
CD2: “Monthly 2[year]”: Refers to 
alternate months starting w ith February 

Filing: Label all CDs/Flash Disks with 
a permanent marker as follows: 
  
i) “Archive [Year][District Name]” 
ii) “Archive [Year][Regional Office 

Copy] 
 
*Caution: Use the full year when 
naming (e.g. “2005”), and NOT “05” 

Storage: 
The Flash Disk/CD should be stored in 
another office from the one which your 
database is kept in, preferably in a cool 
dry place where the A/C is on the 
majority of the time 

Storage:  
Store archives in a locked safe  
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5.3 Exporting/Importing data 
 

The TCZCDP Info DBase is designed as a regional database which combines three 
District/ Municipality databases. As described in the previous section, Districts are to 
archive their databases and transport them to the Regional Office in Tanga every six 
months. This is not just for archiving and safe storage purposes. The primary reason is 
for the Regional Office to import each District Info DBase and thereby update the 
overal regional Info DBase. It is important that this step is taken and that the Districts 
view the Regional Info DBase as an umbrella database able to be used for regional 
level reporting. This is particularly important for those CMAs that span District 
boundaries and for broader analyses of the impacts of the TCZCDP. Importing 
procedures for the Regional Office are described in detail in Part 2, Section 6.2 of this 
Guide.
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Section 6. Analysing Data & Generating Reports 
With the TCZCDP Info DBase you can analyse and 
produce a set of predefined reports or you can 
export the raw data to Excel for other analyses.  

6.1 Predefined Reports 
The following subsections provide an outline of the 
types of reports and information that can be 
automatically generated by the Info DBase; with a 
short explanation on each.  

A. Reefs 
The health of coral reefs are monitored by measuring the abundance of a wide range 
of flora and fauna on the basis that high abundance of most species will indicate 
healthy status of the reef. For example if the number of groupers (chewa) increases it 
suggests populations are recovering. If live coral cover increases it suggests reefs are 
recovering from previous coral death (due to dynamite fishing or bleaching). However, 
there will be other species where high abundance is cause for concern because these 
are species that thrive on damaged coral reefs, examples being certain algae and 
sea urchins. These can also be useful indicators for reef health4.  
 
The reef health variables are divided into three broad groups4: 
§ Benthic fauna and flora, measured by the line intercept method (10m transect) 
§ Mobile invertebrates, measured in 10m x 5m transects (100m2) 
§ Fish, measured in 50m x 5m transects (250m2) 

 
Benthic Fauna and Flora 
 
Primary indicator variables from the benthic data for reports in the Info DBbase are: i) 
Live coral; ii) dead coral; and iii) rubble 
 
The report generated shows the average percentage cover of each of these three 
variables. For each survey 10 replicate 10m long transects are done on a reef (see 
Section 2). Therefore, to estimate average percentage cover, the following calculations 
are done for datasets for each survey on each reef, example being for live coral: 
 
Average live coral cover (in centimetres) = Line 1 [total length of live coral] + Line 2 
[total length of live coral] + Line 3 [total length of live coral]… Line 10 [total length of 
live coral] / 10 
 
(where Line 1 = Line intercept transect, replicate no. 1) 
 
Percentage average cover per reef = Average live coral cover (in cm) / 1000 * 100 
(divided by 1000 because the transects are 10m long) 
 
The average percentage of live coral cover on a reef is well recognised worldwide as 
a sensitive measure of reef health. Simply put, the more live coral cover the healthier 
the reef. Conversely, an increase in dead coral will suggest the reef is deteriorating, 
possibly due to bleaching, disease or crown of thorn starfish. Rubble has also been 
included. Some rubble is always present naturally on a reef due to storm damage that 
breaks up corals. However, dynamite fishing causes extensive damage to coral by 

                                                 
4 Samoilys, M. (2004) Review of the Village Monitoring Team’s coral reef monitoring programme in 
Tanga. 
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reducing it to rubble rather than leaving it dead and standing, therefore rubble can 
be a useful indicator of dynamite damage.  
 
Mobile invertebrates 
 
Ten mobile invertebrate groups are monitored, and these have been grouped into two 
broad categories: 
 
§ Non-fishery species which include i) starfish and ii) sea-urchins 
§ Fishery species which include i) crayfish, ii) sea-cucumber, iii) shells, and iv) 

octopus. 
 
Since the Programme is not monitoring any invertebrate fisheries in the fisheries catch 
and effort monitoring, the data collected through the Reef Health monitoring provides 
a very useful look at these species: the VMT’s visual surveys provide independent 
estimates of population density of invertebrates on the reefs.  
 
Sea-urchins are possible indicators of reef degradation, since it appears that these 
species thrive when fishing is heavy and corals are dead. Starfish are not currently 
known to be clear indicators of reef health but have been included with the non-fishery 
group for reference. Since they are closely related to sea-urchins but do not have the 
same association with reef degradation, they may provide a useful indication of 
natural variation in population abundance of these invertebrates.  
 
The reports generated show the average density of each of these six invertebrate 
types. For each survey 10 replicate 50m2 transects are done on a reef (see Section 2), 
therefore to estimate average density, the following calculations are done for datasets 
for each survey on each reef, example being for sea-urchins: 
 
Average sea urchin density (no. per 50m2) = Line 1 [total number] + Line 2 [total 
number] + Line 3 [total number]… Line 10 [total number] / 10 
 
(where Line 1 = Transect replicate no. 1) 
 
 
Fish 
 
17 categories of fish are surveyed ranging from identifying a single species (e.g. 
Chazanda – mangrove jack) to grouping all species from a family together (e.g. 
Chewa – groupers). In the TCZCDP Information Management System these 17 
categories of fish have been grouped to form five indicators for reporting using the 
database, based on a mix of criteria: ecology (trophic level in the food chain), fishery 
value and type, and general reef health indicators4. These groups are: 
 

§ Carnivores 
§ Omnivores 
§ Herbivores 
§ Coral health indicators (angelfish and butterflyfish) 
§ Triggerfish (possible relation to sea-urchins) 
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A healthy reef should support decent numbers of these groups within the typical trophic 
pyramid:  

 

 
 
In terms of trophic level and fishery type, fish categories can be grouped quite 
conveniently because gears are selective. For example, traps (madema) mostly take 
the herbivorous parrotfish, surgeonfish and rabbitfish, whereas handlines (mishipi) 
capture the carnivorous groupers, snappers and emperors. Thus, trends in carnivores 
will provide information on the health of these populations that are also prime target 
species in the artisanal fisheries. The pelagics (kolekole) are presented separately. A 
further report for chafi (rabbitfish) and changu (emperors/snappers) is also generated 
since these are primary target species in the Tanga fisheries. 
 
The butterfly and angelfish are grouped together as they are generally associated 
with high and diverse hard coral cover and therefore a high number of these species 
will suggest that the reef is in healthy condition. The triggerfish are possibly an 
indicator of fishing pressure and sea urchins densities because they prey on sea-urchins 
and are targeted by fishers.  
 
The three reports generated show the average density of each of 8 fish groups. For 
each survey 10 replicate 250m2 transects are done on a reef (see Section 2), therefore 
to estimate average density, the reports are based on the following calculations for 
datasets for each survey on each reef, example being for carnivores: 
 
Average carnivore density (no. per 250m2) = Line 1 [total number] + Line 2 [total 
number] + Line 3 [total number]… Line 10 [total number] / 10 
 
(where Line 1 = Transect replicate no. 1) 
 

Carnivores 
 

Omnivores 

Herbivores 
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B. Fisheries  
 
There are two critical variables to collect when monitoring fisheries:  
 
i) Catch; and ii) Effort. 
 
Catch is expressed by weight (e.g. tons or kg) and 
represents the amount of fish caught by the fisher. This may 
be broken down into weight per species, and needs to be 
obtained by fishing trip. It can then be summed by week, 
month, or year, for one fisher or all fishers or a sample of 
fishers (e.g. men over 40 yrs old). Annual catch is a value 
frequently needed by Government staff to obtain 
information on the likely amount of fisheries produce going 
in to a community (perhaps to look at health/nutrition issues) 
or for relating total catch to the likely income generated by 
a community from fisheries.  
 
Effort is expressed in time (e.g. hours, days, fishing trips), and represents the amount of 
effort expended by a fisher to get the catch. Effort is invariably broken down by 
vessel and gear because different gears catch fish at different rates, and usually 
target different species. Therefore, a standard unit of effort is decided on in a 
fisheries monitoring programme that reflects the fisheries that are being monitored and 
the way the data are collected. The standard Effort unit for the TCZCDP is 
vessel/gear.hours. This means that effort is recorded by data collectors in hours, and 
the vessel and gear used are also recorded. This gives the effort as the number of 
hours used by vessel/gear X to collect Y catch. For example, the most common fin-fish 
fisheries in Tanga region are those taken by ngalawa/madema, ngalawa/mishipi and 
ngalawa/jarife. Therefore a typical fishing trip data sheet may record the Catch as 3 
kg of snapper (changu) which the fisher caught in 4 hours (Effort) using 
ngalawa/mshipi.  
 
Once you have catch and effort you can calculate Catch per Unit of Effort (CPUE) 
which is the “Catch Rate”. This simply means how much weight of fish is caught in a set 
amount of time. Clearly if a fisher spends 2 hours and catches on average 4 kg, and 
then the next year spends 2 hrs fishing and catches 8kg, the catch rate has doubled in 
the second year suggesting the fishery has improved. CPUE is the most useful 
parameter5 for assessing a fishery because it is assumed that the higher the catch rate 
the greater the abundance of fish and therefore the healthier the fishery.  
 
CPUE = Catch/Effort 
 
CPUE will increase if the Catch increases but the Effort remains constant, or if the Catch 
remains constant but the Effort decreases. For example, imagine the following typical 
fishing trips: 
 
In 1995 CPUE = 10kg/ 2hrs = 5 Kg per hour 
In 1997 CPUE =  5kg/ 2hrs = 2.5 Kg per hour 
In 1999 CPUE =  10kg/2hrs = 5 Kg per hour 
In 2001 CPUE =  14kg/2hrs = 7 Kg per hour 
 

                                                 
5 A parameter is a measure calculated from variables. Thus, CPUE is a parameter calculated from the 
variables Catch & Effort 
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These data tell us that the fishing trips remained constant, at 2 hours, i.e. Effort 
remained constant, but that Catch changed. First it decreased (from 10kg to 5kg) then 
it increased steadily, from 10kg to 14kg. This is reflected directly in Catch Rate or 
CPUE, and suggests that the fishery was declining from 1995 to 1997, after which it 
picked up and continued to improve to levels in 2001 that were higher than in 1995. 
 
These examples show clearly the important distinction between Catch and CPUE. If 
only Catch is recorded you cannot really say anything about the state of the fishery if 
you do not know how much effort was expended in getting that catch. The following 
example illustrates this: 
 
In 1995 10 kg was caught in 2 hours 
In 1997 10 kg was caught in 4 hours 
 
If you only look at the Catch you might assume the fishery was stable from 1995 to 
1997, but in fact the Catch Rate has halved, because CPUE in 1995 is 5kg per hr, and 
in 1997 CPUE is 2.5 kg per hr, which would suggest the fishery was in decline. 
 
Thus, two critical indicators (variables) are used by TCZCDP when monitoring fisheries: 
i) Catch and ii) Effort, and these are combined to look at trends in CPUE.  
 

C. Mangroves 
Indicator species used in the TCZCDP database are:  
 

i) Avicennia marina 
ii) Rhizophora mucronata 
iii) Ceriops tagal 
iv) Bruguiera gymnorrhiza 

 
To assess the status of mangroves in the CMAs and villages, the density (number/plot) 
of the four species calculated against maturity levels which include: trees, saplings, 
seedlings; and also for stumps. Similarly, for harvesting levels, the numbers per acre 
harvested of the four species are assessed for all maturity levels.  
 
Other predefined reports include:  
 
a) Effectiveness of land patrols:  
Ø No. of land patrols/month 
Ø Trends of offences over time 
Ø Summary of actions taken 
Ø No. of poles illegally harvested 
Ø Replanting and Survival in relation 

to offences 
Ø Illegal harvesting v/s offences 
Ø Species by maturity levels v/s 

offences 
 
 
 

b) Effectiveness of planting efforts:  
Ø Replanting v/s survival by species 
 
c) Effectiveness of land patrols:  
Ø No. of land patrols per month 
Ø Trends of offences over time 
Ø Summary of actions taken 
Ø No. of poles illegally harvested 
Ø Replaning and survival v/s offences 
Ø Illegal harvesting v/s offences 
Ø Species by maturity levels v/s 

offences 
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D. Patrol Data 
Data collected through patrols is used in connection with fisheries, mangroves and reef 
data in order to generate reports. The reason for this is patrols are a means to an end, 
and it was felt that these reports would be a way in which the Programme would be in 
a better position to reflect on the effectiveness of patrols in relation to (for example) 
ecosystem health.  
 

E. Socio-economic data 
The Programme only started monitoring socio-economic variables in 2004 and 
therefore the data collection design and data collected to date are still at the 
development stage1. The Info DBase has included the data entry forms that are 
currently used but no reporting forms have been designed because it is too early to 
select indicators. TCZCDP plans to develop this component of its monitoring programme 
to assess socio-economic aspects of the Programme in 2005. It is therefore highly 
recommended that new socio-economic data are not entered using the current data 
entry forms in the Info DBase until the socio-economic component has been properly 
developed, the data entry forms reviewed and the report forms designed 
.   
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Section 7. Using Monitoring & Assessment for Adaptive 
Management  

 

7.1 What is Adaptive Management?  
The world around us is continuously changing.  Just when we think we finally understand 
our environment, the natural resources we are responsible for managing, and the 
people we seek to manage them with, a completely unpredictable event will occur that 
has significant implications for our work!   
 
It is therefore extremely difficult (and unwise) to define policy or practice and assume 
that that it is the “best” for a particular management issue, irrespective of the future.   
 
Adaptive Management “incorporates research into conservation action. Specifically, it is 
the integration of design, management, and monitoring to systematically test assumptions in 

order to adapt and learn”6 
 
Often, we simply use our common sense and knowledge to “adapt” to changes in our 
environment. However, managing natural resources involves dealing with a wide and 
complex range of circumstances which makes it difficult to assess a situation based on 
common sense alone. There are: 
 

- Physical factors such as 
weather and currents;  

- Ecological factors such as 
regeneration rates and 
predator-prey 
interactions;  

- Social factors such as 
culture, religion and 
demographic structures; 
and  

- Political factors such as 
the type of government, 
among others 

 
 

Consequently, we need to treat our decisions and actions as experiments. We can do 
this by clearly defining what “hypotheses” we are making at the very beginning and 
testing them through our actions in a systematic manner. The following example 
illustrates this process.  

                                                 
6 Salafsky, N., R. Margoluis, and K. Redford. 2002. Adaptive Management: A Tool for Conservation 
Practitioners. Washington, D.C.: Biodiversity Support Program. 
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Management Decision: Ban dynamite fishing 

Hypothesis: If dynamite fishing stops/decreases, reef health will improve, which will 
result in improved fisheries 

Experimental action(s):  

i) Ban dynamite fishing and ensure that the ban is enforced 

ii) Monitor trends in incidences of dynamite fishing, reef health and 
fisheries before & after the ban 

Critical Reflection: Analyse your data to see if your assumption(s) were valid - Did 
reef health improve as a result of reduced incidences of dynamite fishing? If so, did 
this result in/contribute to improved fisheries?  

Assessment: Little/no change in the incidence of dynamite fishing; or reef health 

Management Decision: Introduce an awareness campaign in addition to enforcement 
activities 

7.2 How do we practice Adaptive Management?  
 
Effective adaptive management requires managers to complete all steps in the cycle 
illustrated below.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Critical reflection is an important tool for adaptive management – this means 
interpreting your experiences and data to create new insights and agreement on 
actions. Without critical reflection, monitoring data will not be useful for adaptive 
management.  
 
Critical reflection requires going beyond collecting, analysing and reviewing data. It 
involves questioning what is normally taken for granted. It is especially important to 
question the assumptions made when developing management plans, and understand 
which actions work, which do not and why.  
 
Critical reflection can take place through a number of different events, such as weekly 
meetings, reporting on progress, annual planning meetings, and evaluations and 
reviews7.  

                                                 
7 From IFAD (2001) Managing for Impact in Rural Development. A Guide for Project M&E.  

� Design/Adjust 
Management Plan � Develop/Adjust 

Monitoring Plan 

� Implement the 
Management & 

Monitoring Plans 

� Analyse Data & 
Communicate results 

� Critically reflect on analysis 
of data & experiences to assess 

the situation 
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A. Reporting & Feedback Mechanisms  
 
From the full list of predefined reports available in the Info DBase, the following 
reports were selected to be circulated at both District & Village levels on a semi-
annual and annual basis:  
 
Fisheries:  

i) Fish catch trend 
ii) Catch per Unit Effort (CPUE) trend 
iii) Revenue trends 

 
Reefs:  

i) Graph A: Densities of fish by trophic level 
ii) Densities of mobile invertebrates (Fishery) 
iii) Benthic cover in relation to offences 

 
Mangroves:  

i) Species by maturity level 
ii) Harvesting levels 
iii) Replanting v/s survival by species 
iv) Number of poles illegally harvested 

 
 
The District Offices are primarily responsible for ensuring that reports are circulated to 
the villages. This will involve receipt and distribution of CMA reports from the Regional 
Support Unit, and generation and distribution of village level reports generated by the 
District office, as illustrated in the diagram below.  
 
 

 

V/Govt 
Village 
Reports 

District 

District 

District 

Region – 
Support 

Unit CMA 
Reports 

CCC 

V/Govt 
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B. Tips on Organising & Managing Events for Critical Reflection 
Simply holding a meeting or producing a report is not sufficient. A systematic and 
deliberate approach is required to ensure that the events actually result in adaptive 
management.   The following tips are useful to ensure that this is achieved:  
 

- Plan for the event, and ensure that it is reflected in annual work plans and 
budgets 

- Time the event; Ensure that the events are timed appropriately – far enough 
apart to allow for new data and information and frequent enough to allow for 
timely decisions 

- Consider the Participants  

o Present the data in such a way that it is useful to the participants. 
Consider their information needs and ability to interpret and 
understand the information 

o Make sure you create “spaces” for individuals to voice their opinions 
honestly and openly. In a heterogeneous group, it is often useful to 
create smaller groups based on like interests, gender, status, etc.; 

- Consider Non-Participants. Not everybody can attend meetings or 
write/receive reports. However, information and assessment is useful to 
everybody that uses or has a stake in the natural resources. Ensure that the 
information is accessible to all stakeholders in a format they can understand.  

- Focus on understanding and deciding rather than describing. We generally 
spend a lot of time telling each other what has been done, as opposed to 
taking the time to understand successes, weaknesses and define actions. To do 
so, ask people to consider the following questions:  

o What is happening/What happened?  
o Why is it happening?  
o What are the implications for our plans and actions? 
o What should we do next?  

 
- Ensure that the outputs of meetings are action-oriented; Focus on 

documenting “actions needed”, “persons responsible”, “deadline”, and “follow 
up actions (who and how)” 
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Annex Two: Examples of Data Collection Forms  
 

1) MANGROVES 
 
A. Harvesting Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ufuatiliaji wa Uotaji wa Miche iliyopandwa (Replanting & Survival Monitoring Sheet)  
 
Muda wa kutoa taarifa (Reporting period) ……………….. 
 
Eneo la msitu (Site) ……………… Kijiji (Village) ………………… Wilaya (District) ………………  
 
Mkusanyaji Takwimu (Rapporteur) ……………………………………. 
 
Tarehe 
(Date) 

Block 
(Block) 

Mahali 
(Location) 

Tarehe ya kupanda 
(Date of planting) 

Idadi 
iliyopandwa 
(No. planted) 

Aina iliyopandwa 
(Species planted) 

Eneo iliyopandwa 
(Area planted) 
 

Iliyopona  
(Survival) 

Maoni 
(Remarks) 

       Idadi (No) %  
          

Ufuatiliaji wa uvunaji (Harvesting Monitoring Sheet)  
 
Muda wa kutoa taarifa (Reporting period) ……………….. 
 
Xxx (Site) ……………… Kijiji (Village) ………………… Wilaya (District) ………………  
 
Mkusanyaji Takwimu (Rapporteur) ……………………………………. 
 
Tarehe 
(Date) 

Eneo alilovuna 
(Area of harvest) 
 

Jina la Mwombaji 
(Name of harvester/applicant) 

Aina aliyovuna 
(Species harvested) 

xxx 
(Mature Category) 

Idadi Aliyovuna 
(No. harvested) 

Thamani 
(Total 
value)  

Maoni 
(Remarks) 
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B. Ecological Monitoring Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mangrove Monitoring Data Sheet  
 
Date:  Village (Kijiji):  Site No:  

Lon: GPS reading beginning 
transect Lat:  

Compass direction of transect:  

Plot 
(Shamba) 

Species 
(Aina ya mikoko) 
 

Mature category/Stump  
(Kiwango cha 
ukuali/ukatwaji) 

No 
(Idadi) 

Notes 
(Maelezo) 

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Avicennia marina (Mchu) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Rhizophora mucronata 
(Mkoko magondi) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Ceriops tagal 
(Mkandaa) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Bruguiera gymnorrhiza (Mzinzi) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Sonneratia alba (Mlilana) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Xylocarpus granatum (Mkomafi) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Heritiera littoralis (Munu, 
Msikundazi) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Lumnitzera racemosa (Mkandaa 
dume) 

Stump (kisiki)  

  

 Tree (mti mkubwa) 
 Sapling (mti mdogo) 
 Seedling (mche) 
 

Pamphis acidula (Mkaa pwani) 

Stump (kisiki)  

  

 

Mangrove Soil Macro fauna Data Sheet (Fomu Ya Wadudu Wanopatikana Kwenye Mikoko) 
 
Date:  Village (Kijiji):  
Site (Eneo la msitu):   Zone (Kanda):  Plot (Shamba):  
GPS reading beginning transect Lon: Lat: 
Compass direction of transect: 
 
Plot (Shamba) Quadrant (Ubao) Macrofauna 

(Wadudu) 
Tally marks (Namna 
ya kuhesabu) 

No. (Idadi) 

     
     
     
 



33 

2) FISHERIES 
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35 

3) REEFS 
 
 
 
 
 
 
 

 
LINE INTERSECT TRANSECT FORM 
 
 
 
 
 
 

Date:  

MGT AREA ………….. 
REEF: ……………………… 
RECORDER: ………………… 

LINE VIUMBE 
1)   

2)   

3)   

4)   

5)   

6)   

7)   

8)   

9)   

10)   

11)   

12)   

13)   

14)   

15)   

16)   

17)   

18)   

19)   

20)   

21)   

22)   

23)   

24)   

25)   

26)   

27)   
28)   
29)   
30)   
31)   
32)   
33)   
34)   
35)   
36)   
37)   
38)   
39)   

SUMMARY 
 

MC  
MH  

MHM  
MK  
MKK  
ML  
MJ  
MN  
MW  
OT  
SP  
CA  
RB  

TOTAL  
 

MOBILE 
INVERTEBRATES 
 

VIUMBE IDADI 
MACHO  
MAWE  
MOTO  
BODO  
TOTAL  
PWEZA  
KAMBA  
NYERA  

JONGOO  
NYALI  

K’PWEZA  
MAKOME  

TAWANGWE  
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DATE: 
REEF:  
 

MGT. AREA 

RECORDER:           
LINE           
           
CHAFI           
CHANGU           
CHAZANDA           
TEMBO           
HARAKI           
CHEWA           
MILEA           
KITAMBA           
KANGAJA           
KIPEPEO           
MBONO           
MWASOYA            
MKUNDAJI           
KIKANDE/KIDUI           
KOLEKOLE           
KANGU SMALL           
KANGU LARGE           
           
 

Observations on dynamite blast spots (nos, levels of destruction etc):  

Observations on rubbish found within the closed reef (nets, nylon bags etc):  



37 

4) ENFORCEMENT 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

Mafuta yaliotumika: 
……………………….lita 

TAARIFA YA DORIA 
 
 
 

TAREHE ……/…../…..      
           Boma-Mahandakimi 
 

   
      Deep-Sea Boma 

 
     Mwanrongo-Sahare 

 
Kuondoka: …………….. 

        
  Mtang’ata 

 

 
     Boza-Sange 

 
     Mkwaja-Sange 

 
Kurudi: ……… 
 

 
Mtoa taarifa…………………… 

 

1………………………. 2…………………………. 3………………………… 4……………………….. 
5……………………….. 6…………………………. 7………………………… 8………………………. Washiriki: 
9……………………….. 10……………………….. 11………………………… 12………………………… 

 
Maoni:  

Matukio ya uhalifu yaliyotolewa taarifa: 
Mahali Muda Kipimo  

kijografia 
Chombo 
No. /Mature 
category 

Jina la 
chombo/Zana 

Jina la mwenye 
chombo/Mhalifu 

Kosa/Aina ya 
mikoko 

Hatua zilizo 
chukuliwa 

Sahihi 
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Annex Three: List & description of predefined reports in Database  

A. Reefs  
Information 
Types 

Possible Uses of the 
Information 

Reports 

Status of 
Reefs 

Identify needs for 
management interventions 
(e.g. increase enforcement 
efforts, close new reefs, 
etc.) 

Ø Graph A: Densities of Fish by 
Trophic Level 

Ø Graph B: Densities of Fish by 
Trophic Level 

Ø Graph C: Densities of Chafi & 
Changu 

Ø Densities of Mobile Invertebrates 
(Non Fishery) 

Ø Densities of Mobile Invertebrates 
(Fishery)  

Effectiveness 
of 
Management 
Efforts 

Demonstrate benefits of 
closing reefs 
 
Assist with motivating 
villagers to participate in 
management efforts 

Ø No of Sea Patrols/Month (in 
relation to offences) 

Ø Trends in Benthic Cover (in relation 
to offences)  

 
Indicators:  

Indicators/Cluster Species 
Graph A: Trend in mean density of fish by trophic level 
Pelagic /schooling Kolekole 
Carnivores/high trophic level/high fishery 
value 

Chewa, Tembo, Chazanda, Haraki, 
Changu 

Omnivores – carnivores/ medium trophic 
level/medium fishery value 

Mleya, Kitamba, Mkundaji 

Herbivores /medium trophic level /medium 
fishery value 

Kangu –kidogo, Kangu –mkubwa, 
Kangaja, Chafi 

Graph B: Trend in mean density of indicator fishes 
Coral health indicators/ value in aquarium 
fishery 

Kipepeo, Mwasoya 

Possible indicators of sea urchin populations Kikande /kidui 
  
Graph D: Densities of Mobile Invertebrates (Non Fishery) 
Sea urchins  Ufuma, Macho, Mawe, Moto, Bodo 
Starfish Kiti cha pweza, Tawangwe 
Graph E: Densities of Mobile Invertebrates (Fishery) 
Crayfish  Kamba 
Sea cucumber Jongoo 
Shells (Molluscs) Makome, Nyale 
Octopus Pweza 
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B. Fisheries 
Information Types Possible Uses of the 

Information 
Reports 

Status of Fisheries 
Ø Fish Catch Trend   
Ø Catch per Unit Effort 

(CPUE) 

Financial Returns 
from the fisheries Ø Revenue Trends 

Effectiveness of 
Management Efforts 

- Promote and encourage use of 
appropriate gear in 
appropriate places 
 
- Encourage alternative 
livelihood practices (e.g. 
farming) 
 
- Guide decisions regarding 
enforcement activities to 
promote compliance with reef 
closure & destructive practices 
(e.g. dynamite fishing) 
 
- Guide budgetary allocations 
for fisheries management 

Ø No of Sea Patrols per 
month & Offences  

 
 

C. Mangroves 
Information 
Types 

Possible Uses of the 
Information 

Reports 

Status of 
Mangroves  Ø Species by Maturity level 

Mangrove 
Harvesting 

Guide approval of 
requests for permits to 
harvest (how much, where, 
which species) Ø Harvesting levels 

Effectiveness of 
land patrols 

Guide enforcement efforts 
(identify repeat 
offenders; increase / 
decrease patrols) 

Ø No. of land patrols/month 
Ø Trends of offences over time 
Ø Summary of actions taken 
Ø No. of poles illegally harvested 
Ø Replanting and survival in 

relation to offences 
Ø Illegal harvesting v/s offences 
Ø Species by maturity levels v/s 

offences 

Effectiveness of 
planting efforts 

Guide planting for 
mangrove planting (how 
much; where (medium); 
which species) 
 
Promote and encourage 
village participation  

Ø Replanting v/s survival by 
species 
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PART TWO  

TCZCDP INFO DBASE USERS GUIDE 

 

 
 
Version 1.0   
  

Click on user name/user group or password to change settings 
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Section 8. Introduction 

The Tanga Coastal Zone Conservation and Development Programme’s Information 
Management System uses a database-driven application (the Info Dbase) designed to 
store data collected by the Programme and facilitate the processing and analysis of that 
data.  

1.1 Topics Discussed in this Guide 

This Guide describes how to use the TCZCDP Info DBase, with details on how to install and 
use the system 

1.2 Who Should Use This Guide 

This Guide is intended for use by persons administering and using the Info Dbase, and 
contains information pertaining to installing, using and administering the InfoDbase. 

1.3 Other Support Services 

Should there be any queries or need for additional support, database users should 
contact IUCN EARO using the contact details provided below:  
 
Dr. Melita Samoilys  
Technical Coordinator, Marine & Coastal Ecosystems 
IUCN EARO 
Email: melita.samoilys@iucn.org 
Tel: +254-20-890605-12 
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2 Installing, Logging On, Accessing the System 

This chapter describes how to install the Info Dbase and how to log-on to it. 

2.1 Installation Instructions 

If you have previously installed the Info Dbase, you must uninstall it before installing a new 
version (see 2.2 below).  
 
To install InfoDbase software, do the following:  

A. If the CD auto runs, the setup will start automatically and you will see the screen 
shown below. Follow the simple instructions given by the wizard as you move 
along.  

 

 
 



44 

B. Click on Next and type in the name of the organisation, the company and enter 
12345 as the serial number as shown below:  

 

C. The soft ware will install to the directory suggested in the “Destination Directory” 
box as shown below and you are ready to run the application for the first time.  
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D. In case the CD does not automatically run, do the following:  

• Double click on the "My Computer" icon on your desktop or from the start menu in 
windows XP.  

• Right click on your CD-Rom icon, and select "Explore"  
• Navigate to the setup file   
• Double click on the file setup.exe  
• During installation, you will be asked to specify the Destination Directory where 

you want the application to be installed. We recommend that you choose the 
default 

2.2 Uninstalling 

To uninstall the database, use the "Add/Remove Programs" facility in the "Control Panel" 
of Windows.  

2.3 Logging On/Accessing System 

2.3.1 Security 
The system includes a security feature that requires the user to supply a valid user name 
and password before they can use the database as shown below: 

 

 
 

On installation, the Regional Data Administrator (RDA) will set user names and passwords. 
To do so, the RDA should initally log on using the user name admin and password admin. 
Immediately after doing so, the RDA should change his/her user name and password and 
ensure that he/she writes down the new user name and password and puts this in the office 
safe for security reasons.  
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To change user names - click File menu and select Database Users as shown below. Please 
note - User names and passwords are case sensitive. 

 
The following dialog box appears: 

 
 

Recommended User Levels & User Rights are as follows: 
 

User Rights 
User Data 

entry 
Edit/Delete 

Data 
View 

Reports 
Change 
Settings 

Regional Data Administrator NO YES YES YES 
Monitoring Coordinator NO NO YES NO 
District Data Entry Clerk YES NO YES NO 
District Data Administrator NO YES YES NO 
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3 Setting up the system  

This chapter describes how to use the general features of the software. It begins by 
showing you how to navigate through the InfoDbase and describes the settings that need 
to be done before full utility of the InfoDbase can be realised. Later on in this chapter the 
use of the software will be described. 

3.1 Navigating through the forms 

Most forms contain a navigation bar to help you edit and modify records similar to the 
one in the figure below. The number representations on the below diagram are as follows: 
 

 
 

 
 
 
 
 

1. Moves to the previous record. To do that, simply click on the button labeled 1. 
2. Moves to the next record. To do that, simply click on the button labeled 2. 
3. Adds a record. To do that, simply click on the button labeled 3. A place in the grid 

will be created and the pointer will be focused in that place allowing the user to 
type in the necessary data. 

4. Edits an existing record. Highlight the data in the grid that you would like changed 
using the mouse by clicking on it then simply click on the button labeled 4. The user 
will now be able to modify the existing data that was highlighted. 

5. This is for canceling what you were doing, to do that click on the button and the 
active window will automatically close. If the user does not save but clicks this 
button, the data the user had entered might not be saved. 

6. Button 6 will close the active window. 
7. This will delete any highlighted data or record. 
8. This is simply for saving records that have been added or modified in any manner 
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3.2 Settings 

For security purposes, the settings can only be changed by the Regional Data 
Administrator, who will do so during the first installation and thereafter, as need arises.  
Please note – settings MUST be the same for all the Info Dbases in all Districts and at the 
Region. If changes are made in one and not the other – you will not be able to import/export 
the database from the Districts to the Region.   

3.2.1 Districts 
For District settings go to Settings>Districts as illustrated below. 

 
A window will appear like the one shown in the picture below that will assist you to Add, 
Edit, Delete as well as Save any changes made to both the Districts and/or Villages. Each 
District may have one or more villages under it. When a new District has just been added, 
the user can add the villages in the grid under the Village field. 
 

 

 

 The Districts table 
has an additional 
column called Default 
which helps in 
identifying where the 
data came from 
during importing at 
the regional office. 
One and only one  of 
the Districts should be 
made the default at 
the District level - 
even if only one 
District has been 
defined 
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Adding a District & Villages 
Click the Add button under District. A blank entry space will automatically be created as 
shown below.  

 
 
Under the village’s grid, click Add to key in the villages that fall under the District entered 
above. You may add all the villages that exist in that particular District. See examples 
below. 

 
NB: The system accommodates more than one District but the user must specify only one as 
the default District.  

 

Type in name of new 
District in blank entry 
space and indicate 
whether the District is 
the default one for 
data entry. True = 
Default.  
In this example, Tanga 
is the default District.  

Click Add to key 
in villages for a 
particular district 
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3.2.2 Collaborative Management Areas (CMAs) 
For CMA settings go to Settings>Collaborative Management Areas illustrated below. 

 
A window will appear like the one shown in the picture below that will assist you to Add, 
Edit, Delete as well as Save any changes made to CMA, Reefs and/or Village. Each CMA 
may have one or more reefs and/or villages under it. When a new CMA has just been 
added, the user can add the reefs in the grid under the Reefs field in the Reefs tab or 
villages in the grid under the Village field in the Villages tab.  
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Adding a CMA 
Click the Add button under CMA grid. A blank entry space will automatically be 
created as shown below.  This space will allow the user to type in a CMA name as 
demonstrated in the example below 

 

 

 

Click on Add 
and type in the 
CMA name  

 

Under the Reef Name grid 
and under the Reef tab, the 
user can click Add to key to 
add the reefs that fall under 
the area entered above.  
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Under the Village’s grid under the Villages tab, the user can click Add to choose the 
villages that fall under the CMA entered above. See examples below. 

 

3.2.3 Data Recorders 
For data recorders settings go to Settings>Data Recorders as illustrated below. 

 
The following settings form should appear 

 
 

Select the village you want to 
add to the CMA by clicking 
here 
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To add a new data recorder click on Add and select from the relevant columns (Fisheries, 
Reef, Patrols and Mangroves) which data forms the recorder is allowed to gather. By 
default the new recorder is assumed to be able to enter no records. 

 
 
Enter the new recorders name and choose their permissions in the fields besides the 
recorders name 
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Save the changes as necessary and click on the close button to exit. 
 

3.2.4 Frame Survey 
For data recorders settings go to Settings>Frame Survey as illustrated below. 
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The following form will appear:  

 
After each record, click save and then add to enter a new record 
 
 

3.2.5  Mangrove Settings 
To enter mangrove settings go to Settings>Data Recorders as illustrated below. 

 
 
Select Mangrove Species to add, edit or delete a species. You may also enter the 
maturity category from the sub menu shown above 

Once you have 
selected the District, 
Village, Month and 
Year - choose each 
boat type and fill in 
the number of boats 
for each type 
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Use the navigation buttons to Add, Delete, Edit, Save or Cancel any entry. 
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3.2.6 Patrol Settings 
The patrol settings are similar to the mangroves settings. 
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3.2.7 Reef Health Settings 

 
 
To enter the reef fish count species and their descriptions navigate as above and click on 
the fish count species item. The following form should appear. 
 

 
You may add, edit or delete as you wish the fish types and categories, descriptions and 
their names. 
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To enter reef closing dates, use the following form; 

 
 
Navigate as before to the mobile invertebrates item and the following form should 
appear. 
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From the above forms any necessary changes or additions can be made. The same 
procedure can be used for LIT categories 
 

 
 
To enter information about transect areas navigate to the transect area form and click on 
it. You may then modify the relevant area using the edit button and save when you are 
done. While editing and before saving the changes, if you do not wish to retain the 
changes, you may click on the cancel button. 
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3.2.8 Fisheries   
For data recorders settings go to Settings>Fisheries as illustrated below. 
 

 
 
Depending on the selection you choose, the following forms will appear. The Boat types, 
Fishing Gears and Fishing ground forms can be modified simply by using the editing and 
navigation buttons as done previously 
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To enter new species category, click on the add button as shown below 

 
 
To enter a new species for a category, click on the add button as shown below 
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4 Entering Data   

4.1 Fisheries Data 

• To enter fish catch data, go to Data > Fisheries as shown below.  
 

 

 Alternatively you can click on the icon shown on the left. 
 

• On the form, you can view/enter data either in Kiswahili or English as shown 
below 
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Note: The data in the diagram is sample data (You should fill in using your own data). 

Entering Data 
To enter data, click the Add button  

• Select the Village (Kijiji), Recorder (Mtoa Taarifa), Date (Tarehe) and Time (Saa). 
• Enter the Name of the Fisher (Jina la Mvuvi) and the Number of Crew (Idadi ya 

Wavivu) in the respective fields. 
• Select the Type of Boat (Aina ya Chombo). 
• Select the Type of Gear (Aina ya Mtego) and enter the Number of Gears (Idadi 

ya Mitego). 
• Select the Fishing Ground (Sehemu Aliyovua), enter the Hours Spent Fishing 

(Muda wa Uvuvi) and the Value of Fish (Thamani). 
• Enter the Weight (Uzito wa Samaki) and Number of Fish (Idadi ya Samaki) 

respectively. Specify whether the weight was Estimated (Kubuni) or Weighed 
(Uliopimwa) and number of fish was Estimated (Kubuni) or Actual 
(Waliohesabiwa). 

• Select the appropriate BAC Survey days by clicking Day 1, Day 2, and/or Day 3. 
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• Click the Samaki Walioteuliwa Kuhesabiwa (Sampled Fish) tab and under it, fill 
in the required information for Idadi (Pieces) and Uzito(Weight).  
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To enter the lengths of the individual fish, click inside the appropriate Urefu (Length) 
field box and another form will automatically appear with the numbered 1 to the 
number of fish you filled in the field Pieces as shown below.  
 

 
 

Fill in the length(s) of each fish then click the Close buttons. The Fish Catch Monitoring 
Data Sheet will remain active. Click the Save button to save the changes. 

 

4.2 Reef Data 

4.2.1 Reef Fish Count 
To go to the Reef Fish Count Form, go to Data>Reef Monitoring> Reef Fish Count 

 

-Alternatively, click on the icon resembling the 
illustration on the left. 
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To add data to the form, do the following: 
• Click on the Add button so that the form looks like the illustration below. 

 
 

• Choose the Date, Reef and Recorders as required. There can be up to ten 
recorders, so use the scroll bar to enable you to enter the remaining recorders if 
necessary. See illustration below. 

 

 
• Double-click inside the rectangle under 1 which is in the Line field as demonstrated 

below, to allow you to start keying in your data. A window will open allowing you 
to fill in the necessary information for all the lines and for each recorder. See 
illustration below. 
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• Click Save or click on the comments tab to allow you to write any necessary 
comments before saving. An illustration of how the comment tab looks like is below. 
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4.2.2 Line Intersect Transect and Mobile Invertebrates Form 
 
On the Data menu, click Reef Monitoring and then LIT & Mobile Inverts as shown below: 
 

 
 

-Alternatively, click on the icon shown on the left. 
 
The following form appears (sample data is shown here, the actual data may be 
different): 
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To add new data: 
 

• Click the Add button. The form now looks as shown below: 

 
 

• Select the Date, Reef and recorder as required. See illustration below. 
 

 
 

• Click Add again to enter the Line Intersect Transect data (Line and Viumbe). 
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• Add your data as shown in the example below. In the Line part enter the ranges of 
the distances. The first range will be from 0 to e.g. 15. The next line will be filled 
in with the first digit of the range for you and you fill in the ending part of the 
range as in the form from the field. Select the category (viumbe) as shown below: 

 

 
• Click Add again to add more lines. 
• To enter the mobile invertebrate counts, click under idadi for the desired MOBILE 

INVERTEBRATES and enter the number.  
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• After entering all the details, click Save to save and view a summary as well as the 
total that will be seen under the SUMMARY title. See example below. 
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4.3 Mangrove Data 

4.3.1 Mangrove Monitoring Data Sheet 
To enter data in the Mangrove Monitoring Data Sheet, do as follows; 
 

• Go to Data>Mangrove>Monitoring Data Sheet as illustrated below. 

 
 

• Wait for a window to appear as the one below and click the Add button. 

 
 

Alternatively, click on 
the icon 
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• Choose the date from the Tarehe(Date) field, Village from the Kijiji(Village) field 
and enter the required Longitude, Latitude and Compass Direction of Transect in 
the Longitude, Latitude and Compass Direction of Transect fields respectively as 
shown below and then click the Add button to enter the remaining data in the grid 
that will become active after the click of the button. 

 
• Type in the Plot name in the Plot(Shamba) field. Choose a species from the 

Species(Aina ya Mikoko) field  
• Choose the Mature Category/Stump from the Category/Stump (Kiwango cha 

Ukuaji/Ukatwaji), type in the number in the No(Idadi) field and type in any 
necessary notes in the Notes(Maelezo) field and click Save. 

 

 
• Click Add if you want to put in some more information in the grid and repeat the 

previous process. Do not forget to save by clicking on the Save button. 
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4.3.2 Mangrove Harvesting Monitoring Sheet 
To enter data in the Mangrove Harvesting Monitoring Sheet, do as follows; 
 

• On the Data menu, select Mangrove and then Harvesting Monitoring Sheet as 
illustrated below 

The following form appears.  

 
 

• Choose the from date from the Kutoka(From) field, the to date from the Hadi(To) 
field, enter the required site name from Eneo la Msitu(Site) field, Choose the 
village from the Kijiji(Village) field, and the reporter from the Mkusanyaji 
Takwimu(Rapporteur) field as shown in the illustration.  Click the Add button to 
enter the remaining data in the grid that will become active after the click of the 
button. 

 

Alternatively, click 
on the icon 
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• Type in the date in the Tarehe(Date) field, area of harvest in the Eneo 
Alilovuna(Area of Harvest) field, name of harvester in the Jina la 
Mwombaji(Name of Harvester) field. Choose the species from the given list  in 
the Aina Aliyovuna(Species Harvested) field. Type in the mature category in the 
Kiwango cha Ukuaji(Mature Category) field, the number harvested in the Idadi 
Aliyovuna(No. Harvested) field, the total value in the Thamani(Total Value) 
field, and Remarks in the Maoni(Remarks) field. 

 

 
• Click Add if you want to put in some more information in the grid and repeat the 

previous process. Do not forget to save by clicking on the Save button. 
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4.3.3 Replanting and Survival Rate Sheet 
To enter data in the Replanting and Survival Rate Sheet, do as follows; 

• Go to Data>Mangrove> Replanting and Survival Rate Sheet as illustrated 
below. 

Wait for a window to appear as the one below and click the Add button 

 
• Choose the from date from the Kutoka(From) field, the to date from the Hadi(To) 

field, enter the required site name from Eneo la Msitu(Site) field, Choose the 
village from the Kijiji(Village) field, and the reporter from the Mkusanyaji 
Takwimu(Rapporteur) field as shown in the illustration below.  Click the Add 
button to enter the remaining data in the grid that will become active after the 
click of the button. 

 

Alternatively, click on the 
icon 
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• Type in the date in the Tarehe(Date) field, block in the Block(Block) field, location 

in the Mahali(Location) field, planting date in the Tarehe ya Kupanda(Date of 
Planting) field, number planted in the Idadi(No. Planted) field. Choose the species 
from the  Aina Iliyopandwa(Species Planted) field. Type in the area planted in 
the Eneo Iliyopandwa(Area Planted) field, the number survived in the 
Iliyopona(No. Survived) field, the percentage will automatically be calculated 
and placed in the %(%) field, finally type any remarks in the Maoni(Remarks) 
field. 

 

 
• Click Add to enter more information in the grid and repeat the previous process. 

Do not forget to save by clicking on the Save button. 
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4.4 Patrol Data 

To go to the Patrol Data Form, go to Data>Patrols 

To insert data using the form that will appear, do the following: 
• Click on the Add button. See picture below. 

 

 

Alternatively, click on 
the icon 
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• Enter the date, departure time, return time, participants, and comments (if any), as 
well as the reporter in the appropriate field boxes before ticking the necessary 
CMA (locations) on the upper right side of the form. 

 
• Select the patrol type from the two choices of patrol types given, namely Fisheries 

and Mangrove. 
 

Fisheries Option 
Assuming Fisheries is the option chosen; 

 
• In the grid will appear different data entry fields namely Area, Time, GPS 

Position, Vessel Number, Vessel Name, Vessel Owner, Offence and Action 
Taken. Enter the data in the required fields by either typing or selecting from the 
combo boxes. See illustration below. 

 

 
 
• If more data need to be added into the grid, click the Add button and repeat the 

previous process. When finished, save by clicking on the Save button. 
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Mangrove Option 
 

Assuming Mangrove is the option chosen; 
• In the grid will appear different data entry fields namely Area, Time, No of 

Trees, Mature Category, Weapon, Offender, Species Name and Action Taken. 
Enter the data in the required fields by either typing or selecting from the combo 
boxes. See illustration below. 

 

 
 
• If more data need to be added into the grid, click the Add button and repeat the 

previous process. When finished, save by clicking on the Save button. 
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4.5 Vessel Activity 

To go to the Vessel Activity Form, go to Data>Vessel Activity 

 
The following form appears:  

 
 

 

Alternatively, 
click on the icon 

To insert data, click on 
the Add button 
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• Choose the appropriate Village, Month and Year from their combo boxes as 
shown in the example below. 

 
 

• Click inside the grid below and enter the Number, Vessel Type, Gear Type and 
Days of Uniform Inactivity and type any necessary remarks. See example below. 

•  

 
 

• If you want to insert more data inside the grid, click Add again and repeat the 
previous step. When you finish, save your data by clicking on the Save button. 
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4.6 Socio-Economic 

To Access the Socio-Economic forms from the database click on Data -> Socio-Economic 
and a submenu containing links to all available socio-economic forms will drop down. 
Clicking on any of those sub-menu items will open the relevant forms. Data entry is similar 
to all other forms. 
 
** Please note – As the socio-economic monitoring programme had not been fully developed 
at the time this database was designed, no reports have been created. Consequently, it is 
highly recommended that this component of the database is not used until reports have been 
designed and the database adapted accordingly.  
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5 Reports 

5.1 Accessing Reports 

The TCZCDP database contains 3 main categories of reports. These are fish catch, reef 
health and mangrove reports. To access the reports: 

Click the Reports menu and select the category of report you want 

 
 
Depending on the category you highlighted, one of the following screens appears: 
 
(a) Fisheries 
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(b) Reef Health 

 
 
(c) Mangroves 
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Select the category under Information Types. The Purpose is automatically filled in and 
the reports available under that category are also listed under Reports as shown below: 
 

 
 
Select the relevant report under Reports and click the Preview button (or double-click the 
report name). 
 

5.2 Report Navigation 

All reports have the following buttons for navigating: 

 
 
 
 
Each of the above buttons is explained below: 
1 – Print button. The button enables you to send the current report to the printer. When 
clicked, the following dialog appears: 
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2 – First button. Enables you to navigate to the first page of the report 
3 – Previous. Navigates to the previous page of the report 
4 – Current page. Shows the currently selected page in the report. 
5 – Next. Navigates to the next page of the report. 
6 – Last. Navigates to the last page of the report. 
7 – Zoom. You can "zoom in" to get a close-up view of your document or "zoom out" to 
see more of the page at a reduced size.  
8 and 9 – Enable you to select the range of dates for which you want the report 
generated. 
 

5.3 Report Level 

A report can be generated for region, CMA or village. To determine the level of detail, 
select the option you want as shown below: 
 

  
 
When you select CMA, the following option appears: 

 
 
When you selected Village, the following option appears: 
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5.4 Report Manipulation 

Each report has the following set of buttons for manipulating it: 

 
Create Report enables you to generate the report according to the options specified (e.g. 
date range, CMA, etc) 
§ Comments enables you to add comments to the report and change its title 
§ Save Report enables you to save the report for future reference. 
§ Copy Chart enables you to copy the chart generated to other applications e.g. 

Microsoft Word. 
§ Close enables you to close the report. 
 
Some of these buttons appear disabled initially as shown below: 

 
The Comments and Copy Chart buttons become active after you click Create Report to 
generate a report. 
The Save Report button becomes active after you have added comments to your report. 
 

5.5 Opening a Previously Saved Report 

There are two ways to open a previously saved report. 
1. Click the File menu and select Open Saved Report as shown below: 

 
 
2. Click the Reports menu and select Open Saved Report as shown below: 
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The following form appears: 

 
 

Click the Open Report button as shown below: 

 
The following dialog appears: 

 
Select the report you want to open and click Open button.  
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5.6 Exporting Queries to Excel 

The InfoDbase has a number of queries that can be exported to Microsoft Excel for further 
analysis. 
To export a query to excel, click the Reports menu and select Export to Excel as shown 
below: 

 
 
The following dialog box appears 

 
Select the range of dates and the query you want to export to Excel and click Export 
button (or double -click the report name). 
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The following dialog box appears 

 
 

Type in the name of the file that you want to save the query to and click Save. The query 
is automatically saved and opened in Microsoft Excel as shown below: 
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6 Importing and Exporting Data 

6.1 Exporting Data 

The export facility of InfoDbase enables the user to back up or achive the data and to 
transport the data to the Regional office so that it can be imported into the regional 
InfoDBase (see 6.2). 
 
To export data from the InfoDbase - go to Start, TCZCDP MIS, Export Data:  
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Click on the button next to Export To 

 
 
Enter the name of the file to export data to and click Save. 
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The following screen appears: 

 
 
Click Export button 

 
 

6.2 Importing Data 

To import data, first close the InfoDbase application, then go to Start, TCZCDP MIS, and 
click on Import Data:  

 
 



97 

The following screen appears:  

 
 
 
The following screen appears:  

 

Select the name of 
the file you want to 
import and click 
open 

Click on Import 
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The following screen will appear to show you the progress of the file you are importing 

 
 
 
 
In the event that the settings of the District InfoDbase are different from that of the 
Regional InfoDbase – the importing process will be aborted, and the Regional InfoDbase 
will automatically go back to the version before importation began.  
 

When it is 
finished 
importing, click 
Close 
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When this happens, the following screen will appear:  

 
 
Should this occur, the RDA will need to check the settings of the District InfoDbase. If 
changes to the settings are justifiable, the RDA should make the same changes in the 
Regional InfoDbase and to the InfoDbases of the other two Districts.  If this is not done, you 
will not be able to import the InfoDbase from the other two Districts.  
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A record is automatically kept each time the District InfoDbases are imported to the 
Regional InfoDbase. The record is stored in the same folder where the InfoDbase was 
installed - C:\Program Files\TCZCDP IMS  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you double click on the ImportLog, the following screen will appear:  
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IUCN – Eastern African Regional Programme 
IUCN established the Eastern Africa Regional Office (EARO) in Nairobi in 1986. EARO 
facilitates the implementation of the IUCN Programme in Sudan, Eritrea, Djibouti, Somalia, 
Kenya, Tanzania, Comoros, Seychelles, Uganda and Ethiopia. Through its technical group, 
established in the early 1990s, the IUCN Programme assists members and partners in the 
region with capacity building through the implementation of programmes and projects, 
networking, and technical advice. Specific areas of expertise include: protected areas, 
ecosystem management, biodiversity conservation, environmental planning and strategies, 
and support to environmental NGOs. 

 
IUCN – Marine and Coastal Ecosystems Programme 
The aim of IUCN’s Eastern Africa Marine & Coastal Ecosystems Programme, which has been 
operating since 1992, is to maintain the biodiversity and ecological processes of marine and 
coastal ecosystems in Eastern Africa, to restore their functioning where this has been 
impaired, and to facilitate the sustainable and equitable use of marine resources. Current 
priorities include: the establishment and effective management of marine protected areas, 
sustainably managed fisheries and integrated coastal zone management.  
 
Tanga Coastal Zone Conservation and Development Programme  
The Tanga Coastal Zone Conservation and Development Programme (TCZCDP) started in 
1994 and aims to enhance the well being of coastal communities by improving the health of 
the coastal and marine environment on which they depend. The Programme is working with 
coastal fishing villages to manage the coral reefs, mangroves and other marine resources that 
the villagers depend upon for their livelihoods. Districts and village level institutions are being 
strengthened so that they can undertake integrated management in a sustainable way. The 
Programme is implemented by the three coastal Districts (Muheza and Pangani Districts and 
Tanga Municipality) of the Tanga Region in north-east Tanzania in collaboration with the 
Regional Secretariat, the Ministry of Natural Resources and Tourism, and the Vice-President’s 
Office (Environment). IUCN – EARO has provided technical and managerial advice on behalf 
of the donor, Development Cooperation Ireland (DCI). 

 

 

 

  
 


